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About iPod shuffle

Congratulations on purchasing iPod shuffle.

WARNING: To avoid injury, read all operating instructions in this guide and
the safety information in Chapter 7,“Safety and Handling,” before using
iPod shuffle.

To use iPod shuffle, you put songs and other audio files on your computer and then
sync them with iPod shuffle.

Use iPod shuffle to:
+ Sync songs and playlists for listening on the go

« Listen to podcasts, downloadable radio-style shows, delivered over the Internet
« Listen to audiobooks purchased from the iTunes Store or audible.com

« Store or back up files and other data, using iPod shuffle as an external disk

What's New in iPod shuffle

+ A VoiceOver button that announces track titles and artist names, lets you switch
playlists, and reports battery status

+ Easy and intuitive controls
+ Support for syncing Genius Mixes

+ Support for syncing iTunes U collections


http://audible.com

iPod shuffle Basics

Read this chapter to learn about the features of iPod shuffle,
how to use its controls, and more.

Your iPod shuffle package includes iPod shuffle, the Apple Earphones, and a USB 2.0
cable to connect iPod shuffle to your computer.

iPod shuffle at a Glance

Status light VoiceOver button

Earphone port

Three-way switch
\\ Volume Up
Next/Fast-forward

+—— dlip

Previous/Rewind

Play/Pause

Volume Down

\/

To use the Apple Earphones:
Plug the earphones into the earphone port on iPod shuffle. Then place the earbuds in
your ears as shown.

The earphone
cord is adjustable.




WARNING: Read all safety instructions about avoiding hearing damage in “Important
Safety Information” on page 34 before using iPod shuffle.

You can purchase other accessories, such as the Apple Earphones with
Remote and Mic or the Apple In-Ear Headphones with Remote and Mic, at
www.apple.com/ipodstore. The microphone isn’t supported on iPod shuffle.

Using the iPod shuffle Controls
The front controls, the VoiceOver button, and the three-way switch make it easy to
play songs, audiobooks, audio podcasts, and iTunes U collections on iPod shuffle.

To

Do this

Turn iPod shuffle on or off

Slide the three-way switch (green shading on the switch
indicates iPod shuffle is on).

Play or pause

Press Play/Pause (>u).

Increase or decrease the volume

Press Volume Up (+) or Volume Down (=). Press and hold
the buttons to quickly increase or decrease the volume.

Set the play order

Slide the three-way switch to play in order (&) or
shuffle (23).

Go to the next track

Press Next/Fast-forward (»).

Go to the previous track

Press Previous/Rewind (i) within 6 seconds of the track
starting. After 6 seconds, pressing Previous/Rewind (i)
restarts the current track.

Fast-forward

Press and hold Next/Fast-forward (»).

Rewind

Press and hold Previous/Rewind (i«).

Hear the track title and artist name

Press the VoiceOver (=) button.

Hear a menu of playlists to
choose from

Press and hold the VoiceOver (=) button. Press
Next/Fast-forward (™) or Previous/Rewind (i) to move
through the playlist menu. Press the VoiceOver (=)
button or Play/Pause (»n) to select a playlist. Press and
hold the VoiceOver (=) button again to exit without
making a selection.

Lock the iPod shuffle buttons
(so nothing happens if you press
them accidentally)

Press and hold Play/Pause (>u) until the status light
blinks orange three times.

Repeat to unlock the buttons.

Reset iPod shuffle
(if iPod shuffle isn't responding or the
status light is solid red)

Turn iPod shuffle off, wait 10 seconds, and then turn it
back on again.

Find the iPod shuffle serial number

Look under the clip on iPod shuffle. Or, in iTunes (with
iPod shuffle connected to your computer), select
iPod shuffle in the list of devices and click the Summary tab.

Chapter 2 iPod shuffle Basics
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Connecting and Disconnecting iPod shuffle
Connect iPod shuffle to your computer to sync songs and other audio files, and to
charge the battery. Disconnect iPod shuffle when you're done.

Important: To connect iPod shuffle to your computer, use only the USB 2.0 cable that
came with iPod shuffle.

Connecting iPod shuffle
To connect iPod shuffle to your computer:

Plug one end of the included USB cable into the earphone port of iPod shuffle, and the
other end into a high-power USB 2.0 port on your computer.

Note: Don't connect iPod shuffle to a USB port on your keyboard for charging.

A longer USB cable is available separately at www.apple.com/ipodstore.

The first time you connect iPod shuffle to your computer, iTunes helps you set up

iPod shuffle and sync it with your iTunes library. By default, iTunes automatically syncs
songs on iPod shuffle when you connect it to your computer. You can sync songs while
your battery is charging.

If you connect iPod shuffle to a different computer and iPod shuffle is set to sync
music automatically, iTunes prompts you before syncing any music. If you click Yes,
the songs and other audio files already on iPod shuffle are erased and replaced with
songs and other audio files from the new computer iPod shuffle is connected to. For
information about adding music to iPod shuffle or using iPod shuffle with more than
one computer, see Chapter 4, “Listening to Music,” on page 22.

Chapter 2 iPod shuffle Basics
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Disconnecting iPod shuffle

It's important not to disconnect iPod shuffle from your computer while audio files are
syncing or when iPod shuffle is being used as an external disk. It's OK to disconnect
iPod shuffle if the status light isn't blinking orange, or if you see the “OK to disconnect
message at the top of the iTunes window.

"

Important: If you see the “Do not disconnect” message in iTunes or if the status
light on iPod shuffle is blinking orange, you must first eject iPod shuffle before
disconnecting it. Failing to do so may damage files on iPod shuffle and require you
to restore iPod shuffle in iTunes. For information about restoring, see “Updating and
Restoring iPod shuffle Software” on page 33.

If you enable iPod shuffle for disk use (see “Using iPod shuffle as an External Disk” on
page 28), you must always eject iPod shuffle before disconnecting it.

To eject iPod shuffle:
= |niTunes, click the Eject (2) button next to iPod shuffle in the list of devices.

If you're using a Mac, you can also eject iPod shuffle by dragging the iPod shuffle icon
on the desktop to the Trash.

If you're using a Windows PC, you can also eject iPod shuffle in My Computer or by
clicking the Safely Remove Hardware icon in the Windows system tray and selecting
iPod shuffle.

To disconnect iPod shuffle:
= Disconnect the USB cable from iPod shuffle and from your computer.

Chapter 2 iPod shuffle Basics



About the iPod shuffle Battery
iPod shuffle has a rechargeable internal battery that should be replaced only by an
Apple Authorized Service Provider.

For best results, the first time you use iPod shuffle, let it fully charge for about three
hours. The battery is 80-percent charged in about two hours and fully charged in
about three hours. If iPod shuffle isn't used for a while, the battery might need to
be recharged.

You can sync music while the battery is charging. You can disconnect and use
iPod shuffle before it's fully charged.

Charging the iPod shuffle Battery

You can charge the iPod shuffle battery in two ways:
+ Connect iPod shuffle to your computer

+ Use the Apple USB Power Adapter, available separately.

To charge the battery using your computer:

Connect iPod shuffle to a high-power USB 2.0 port on your computer using the
included iPod shuffle USB cable. The computer must be turned on and not in sleep
mode (some Mac models can charge iPod shuffle while in sleep).

When the battery is charging, the status light on iPod shuffle is solid orange. When the
battery is fully charged, the status light is green. In iTunes, the battery icon next to the
name of your iPod shuffle also shows the battery status. The icon displays a lightning
bolt when the battery is charging, and a plug when the battery is fully charged.

If iPod shuffle is being used as an external disk or is syncing with iTunes, the
status light blinks orange to let you know that you must eject iPod shuffle before
disconnecting it. In this case, your battery may either be still charging or fully charged.

If you don't see the status light, iPod shuffle might not be connected to a high-power
USB 2.0 port. Try another USB 2.0 port on your computer.

If you want to charge the battery when you're away from your computer, you can
connect iPod shuffle to an Apple USB Power Adapter, available separately. To purchase
iPod shuffle accessories, go to www.apple.com/ipodstore.

Chapter 2 iPod shuffle Basics
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To charge the battery using the Apple USB Power Adapter:
Connect the included iPod shuffle USB cable to the power adapter, and plug the other
end into iPod shuffle.

Plug the power adapter into a working power outlet.

Apple USB Power Adapter
(your adapter may look different)

iPod shuffle USB cable

WARNING: Make sure the power adapter is fully assembled before plugging it into a
power outlet. Read all safety instructions about using the Apple USB Power Adapter
in Chapter 7,“Safety and Handling,” on page 34 before use.

Rechargeable batteries have a limited number of charge cycles. Battery life and
number of charge cycles vary by use and settings. For information, go to
www.apple.com/batteries.

Checking the Battery Status

You can check the battery status of iPod shuffle when it's connected to your computer
or disconnected. The status light tells you approximately how much charge is in the
battery.

If iPod shuffle is on and not connected to a computer, you can use VoiceOver to hear
the battery status by pressing the VoiceOver button twice.

Status light when VoiceOver message
disconnected
@ Solid green Good charge “Battery full” or
“Battery 75%" or
“Battery 50%"
Solid orange Low charge “Battery 25%"
@ Solid red Very low charge “Battery low”

Status light when connected to computer

@ Solid green Fully charged
Solid orange Charging
Blinking orange Do not disconnect (iTunes is syncing, or

iPod shuffle is enabled for disk use); may be still
charging or may be fully charged

Chapter 2 iPod shuffle Basics 1
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Setting Up iPod shuffle

Use iTunes on your computer to set up iPod shuffle to play
music and other audio content. Then connect iPod shuffle to
your computer and sync it to your iTunes library.

Read on to learn more about getting started with iPod shuffle, including:

+ Getting music from your CD collection, hard disk, or the iTunes Store (part of iTunes
and available in some countries only) into the iTunes application on your computer

« Organizing your music and other audio into playlists

+ Syncing songs, audiobooks, podcasts, and iTunes U collections in your iTunes library
with iPod shuffle

+ Listening to music or other audio on the go

About iTunes

iTunes is the free software application you use to set up, organize, and manage your
content on iPod shuffle. iTunes can sync music, audiobooks, and audio podcasts with
iPod shuffle. If you haven't already installed iTunes 10 or later (required for iPod shuffle)
on your computer, you can download it at www.itunes.com/download.

After you install iTunes, it opens automatically when you connect iPod shuffle to your
computer. You can use iTunes to import music from CDs and the Internet, buy songs
and other audio from the iTunes Store, create personal compilations of your favorite
songs (called playlists), sync iPod shuffle, and adjust iPod shuffle settings.

iTunes also has a feature called Genius, which creates instant playlists and mixes of
songs from your iTunes library that go great together. You can sync Genius mixes and
playlists from iTunes to iPod shuffle. To use Genius, you need an iTunes account. To
learn how to set up Genius, see “Using Genius in iTunes” on page 15.

iTunes has many other features. You can burn your own CDs that play in standard CD
players (if your computer has a recordable CD drive); listen to streaming Internet radio;
watch videos and TV shows; rate songs according to preference; and much more. For
information about using these features, open iTunes and choose Help > iTunes Help.


http://www.itunes.com/download

If you already have iTunes 10 or later installed on your computer and you've set up
your iTunes library, you can skip to the next section,“Connecting iPod shuffle to a
Computer for the First Time” on page 15.

Setting Up Your iTunes Library
To listen to music on iPod shuffle, you first need to get that music into your iTunes
library on your computer.

There are three ways to get music and other audio into your iTunes library:
+ Purchase music and audiobooks or download podcasts online from the iTunes Store.

+ Import music and other audio from audio CDs.

« Add music and other audio that’s already on your computer to your iTunes library.

Purchasing Songs and Download Podcasts Using the iTunes Store

If you have an Internet connection, you can easily purchase and download songs,
albums, and audiobooks online using the iTunes Store (available in selected countries).
You can also subscribe to and download audio podcasts, and you can download free
educational content from iTunes U.Video podcasts can't be synced to iPod shuffle.

To purchase music online using the iTunes Store, you set up a free iTunes account in
iTunes, find the songs you want, and then buy them. If you already have an iTunes
account, you can use that account to sign in to the iTunes Store and buy songs.

You don’t need an iTunes Store account to play or download podcasts or iTunes U
classes.

To enter the iTunes Store, open iTunes and click iTunes Store (under Store) on the
left side of the iTunes window.

Chapter 3 Setting Up iPod shuffle 13



Adding Songs Already on Your Computer to Your iTunes Library

If you have songs on your computer encoded in file formats that iTunes supports, you
can easily add the songs to iTunes. To learn how to get songs from your computer into
iTunes, open iTunes and choose Help > iTunes Help.

Using iTunes for Windows, you can convert nonprotected WMA files to AAC or MP3
format. This can be useful if you have a library of music encoded in WMA format. For
more information, open iTunes and choose Help > iTunes Help.

Importing Music from Your Audio CDs Into iTunes

iTunes can import music and other audio from your audio CDs. If you have an Internet
connection, iTunes gets the names of the songs on the CD from the Internet (if
available) and lists them in the window. When you add the songs to iPod shuffle, the
song information is included. To learn how to import music from your CDs into iTunes,
open iTunes and choose Help > iTunes Help.

Entering Song Names of and Other Information

If you don't have an Internet connection, if song information isn't available for music
you import, or if you want to include additional information (such as composer
names), you can enter the information manually. To learn how to enter song
information, open iTunes and choose Help > iTunes Help.

Organizing Your Music

In iTunes, you can organize songs and other items into lists, called playlists, in any way
you want. For example, you can create playlists with songs to listen to while exercising,
or playlists with songs for a particular mood.

You can also create Smart Playlists that update automatically based on rules you
define. When you add songs to iTunes that match the rules, they automatically get
added to the Smart Playlist.

You can turn on Genius in iTunes and create playlists of songs that go great together,
based on a song you select. Genius can also organize your iTunes library automatically
by sorting and grouping songs into collections called Genius Mixes.

You can create as many playlists as you like, using any of the songs in your iTunes library.
You can't create a playlist on iPod shuffle when it’s disconnected from iTunes. Adding a
song to a playlist or later removing it doesn't remove it from your iTunes library.

When you listen to playlists on iPod shuffle, all playlists created in iTunes behave the
same way. You can choose them by name on your iPod shuffle.

To learn how to set up playlists in iTunes, open iTunes and choose Help > iTunes Help.

Chapter 3 Setting Up iPod shuffle



Using Genius in iTunes

Genius finds songs in your iTunes library that go great together and uses them to
create Genius playlists and Genius Mixes. Genius is a free service, but you need an
iTunes Store account to use it. If you don't have an account, you can set one up when
you turn on Genius.

A Genius playlist is based on a song that you select. iTunes then compiles a Genius
playlist of songs that go great with the one you selected.

Genius Mixes are preselected compilations of songs that go great together. They're
created for you by iTunes, using songs from your iTunes library. Each Genius Mix is
designed to provide a different listening experience each time you play it. iTunes

creates up to 12 Genius Mixes, based on the variety of music in your iTunes library.

To create Genius playlists and Genius Mixes, you first need to turn on Genius in iTunes.
For information, open iTunes and choose Help > iTunes Help.

Genius playlists and Genius Mixes created in iTunes can be synced to iPod shuffle like
any other iTunes playlist. You can’t add Genius Mixes to iPod shuffle manually.

Connecting iPod shuffle to a Computer for the First Time
The first time you connect iPod shuffle to your computer after installing iTunes,
iTunes opens and the Setup Assistant appears. If iTunes doesn’t open automatically,
open it yourself.

To use the iPod shuffle Setup Assistant:
Enter a name for iPod shuffle. This name will appear in the device list on the left side of
the iTunes window.

Select your settings.

Automatic syncing is selected by default. If you keep this option selected and Genius is
turned on, iTunes syncs Genius Mixes from your iTunes library to iPod shuffle. If Genius
isn't turned on, iTunes fills iPod shuffle with songs from your iTunes library and places
them in the “All Songs” playlist. For more information about automatic and manual
syncing, see the next section.

VoiceOver is also selected by default. Keep this option selected to hear track titles
and artist names, change your playlists, and hear battery status while you listen to
iPod shuffle. For more information, see “Using VoiceOver” on page 24.

Click Done.

You can change the device name and settings any time you connect iPod shuffle to
your computer.

After you click Done, the Summary pane appears. If you selected automatic syncing,
iPod shuffle begins syncing.

Chapter 3 Setting Up iPod shuffle 15
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Adding Music to iPod shuffle

After your music is imported and organized in iTunes, you can easily add it to
iPod shuffle.

6]

To manage how songs and other audio content are added to iPod shuffle from your
computer, you connect iPod shuffle to your computer, and then use iTunes preferences
to choose iPod shuffle settings.

Adding Content Automatically or Manually
You can set iTunes to add music to iPod shuffle in two ways:

« Automatically syncing: When you connect iPod shuffle to your computer, iPod shuffle
is automatically updated to match the songs and other items in your iTunes library.
If Genius is turned on the first time you sync iPod shuffle, iTunes uses up to four
Genius Mixes created from your iTunes library to fill iPod shuffle. If any free space
remains, iTunes syncs additional songs from your iTunes library. If Genius isn't turned
on, iTunes syncs songs and playlists from your iTunes library to fill iPod shuffle.

Later, you can modify automatic syncing options to include selected playlists,
artists, albums, and genres. You can also automatically sync other audio, including
podcasts, audiobooks, and iTunes U collections. See the following sections for more
information.

« Manually managing music: When you connect iPod shuffle, you can drag individual
songs and playlists to iPod shuffle, and delete individual songs and playlists from
iPod shuffle. Using this option, you can add songs from more than one computer
without erasing songs from iPod shuffle. When you manage music manually,
you must always eject iPod shuffle from iTunes before you can disconnect it. See
“Managing iPod shuffle Manually” on page 20.

Syncing Music Automatically

By default, iPod shuffle is set to sync all songs and playlists when you connect it to
your computer. This is the simplest way to add audio content to iPod shuffle—you just
connect iPod shuffle to your computer, let it add songs, audiobooks, audio podcasts,
and iTunes U collections automatically, and then disconnect it and go. If you added
any songs to iTunes since the last time you connected iPod shuffle, they're synced with
iPod shuffle as space allows. If you deleted songs from iTunes, they're removed from
iPod shuffle.

Chapter 3 Setting Up iPod shuffle
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To sync music with iPod shuffle:
Simply connect iPod shuffle to your computer. If iPod shuffle is set to sync
automatically, the update begins.

Important: If you connect iPod shuffle to a computer that it hasn't synced with, a
message asks if you want to sync songs automatically. If you accept, all songs and
other audio content are erased from iPod shuffle and replaced with songs and other
items from that computer. If you don't accept, you can still add songs to iPod shuffle
manually without erasing any of the songs already on iPod shuffle.

While music is being synced from your computer to iPod shuffle, the iTunes status
window shows progress, and you see a sync icon next to iPod shuffle in the list of

devices. When the update is done, you see the “iPod sync is complete” message in

iTunes. A bar at the bottom of the iTunes window displays how much disk space is
used by different types of content.

If you don’t choose to automatically sync music to iPod shuffle during setup, you can
do it later.

If there isn't enough space on iPod shuffle for all your music, you can set iTunes to sync
only selected playlists, artists, albums, and genres.

To set iTunes to sync music from selected playlists, artists, genres, and albums to
iPod shuffle:
Connect iPod shuffle to your computer.

In iTunes, select iPod shuffle in the list of devices, and then click the Music tab.
Select “Sync music,” and then choose “Selected playlists, artists, genres, and albums.”
Select the playlists, artists, genres, and albums you want.

To set iTunes to automatically fill any remaining space on iPod shuffle, select
“Automatically fill free space with songs.”

If you have Genius Mixes, iTunes uses them to fill the space first. If there’s no room for
another Genius Mix, iTunes fills the remaining space on iPod shuffle with other songs.

Click Apply.
The update begins automatically.

If you select “Sync only checked songs”in the Summary pane, iTunes syncs only items
that are checked.

Chapter 3 Setting Up iPod shuffle
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Syncing Genius Mixes to iPod shuffle

You can set iTunes to sync Genius Mixes to iPod shuffle. Genius Mixes can only be
synced automatically, so you can’t add Genius Mixes to iPod shuffle if you manage your
content manually.

If your Genius Mixes don't fill the available space and you select the “Automatically
fill free space with songs” option, iTunes selects and syncs additional songs from your
iTunes library.

To set iTunes to sync selected Genius Mixes to iPod shuffle:

In iTunes, select iPod shuffle in the list of devices, and then click the Music tab.
Select “Sync music,” and then choose “Selected playlists, artists, genres, and albums.”
Under Playlists, select the Genius Mixes you want.

Click Apply.

If “Sync only checked songs”is selected in the Summary pane, iTunes syncs only items
that are checked.

Syncing Podcasts Automatically

The settings for adding podcasts to iPod shuffle are unrelated to the settings for
adding songs. Podcast settings don't affect song settings, and vice versa. You can
set iTunes to automatically sync all or selected podcasts, or you can add podcasts to
iPod shuffle manually.

To set iTunes to update the podcasts on iPod shuffle automatically:

In iTunes, select iPod shuffle in the list of devices, and then click the Podcasts tab.
In the Podcasts pane, select “Sync Podcasts.”

Select the podcasts, episodes, and playlists you want, and set your sync options.
Click Apply.

When you set iTunes to sync podcasts automatically, iPod shuffle is updated each time
you connect it to your computer.

If “Sync only checked songs”is selected in the Summary pane, iTunes syncs only items
that are checked.

Chapter 3 Setting Up iPod shuffle
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Adding iTunes U Collections to iPod shuffle

iTunes U is a part of the iTunes Store that features free lectures, language lessons,
audiobooks, and more, which you can download and sync to iPod shuffle. The settings
for adding iTunes U collections to iPod shuffle are unrelated to the settings for adding
other content. iTunes U settings don't affect other settings, and vice versa. You can

set iTunes to automatically sync all or selected iTunes U collections, or you can add
iTunes U content to iPod shuffle manually.

To set iTunes to sync iTunes U content automatically:
In iTunes, select iPod shuffle in the list of devices, and then click the iTunes U tab.

In the iTunes U pane, select “Sync iTunes U.”
Select the collections and items you want, and set your sync options.
Click Apply.

When you set iTunes to sync iTunes U content automatically, iPod shuffle is updated
each time you connect it to your computer.

If “Sync only checked songs”is selected in the Summary pane, iTunes syncs only items
that are checked.

Adding Audiobooks to iPod shuffle
You can purchase and download audiobooks from the iTunes Store or audible.com, or
import audiobooks from CDs, and listen to them on iPod shuffle.

Use iTunes to add audiobooks to iPod shuffle. If you sync iPod shuffle automatically,
each audiobook in your iTunes library is synced as a separate playlist, which you can
select using VoiceOver. If you manage your content on iPod shuffle manually, you can
add audiobooks one at a time.

To sync audiobooks to iPod shuffle:

In iTunes, select iPod shuffle in the list of devices, and then click the Books tab.
Select Sync Audiobooks, and then do one of the following:

+ Select “All audiobooks.”

+ Select “Selected audiobooks,” and then specify the books you want.

Click Apply.

The update begins automatically.

Chapter 3 Setting Up iPod shuffle
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Managing iPod shuffle Manually

If you manage iPod shuffle manually, you can add and remove individual songs,
playlists, podcasts, and audiobooks. You can add music and other audio content from
multiple computers to iPod shuffle without erasing items already on iPod shuffle.

You can add Genius playlists, but not Genius Mixes, to iPod shuffle manually.

Setting iPod shuffle to manually manage music turns off automatic sync options in
the Music, Podcasts, and iTunes U panes in iTunes. You can’'t manually manage some
content and automatically sync other content at the same time.

If you set iTunes to manage content manually, you can set it later to sync automatically.
To manually manage audio content on iPod shuffle:

In iTunes, select iPod shuffle in the list of devices, and then click the Summary tab.
In the Options section, select “Manually manage music.”

Click Apply.

When you manage iPod shuffle manually, you must always eject iPod shuffle from
iTunes before you disconnect it.

To add a song or other item to iPod shuffle:

In iTunes, click Music or another item in the Library list.

Drag a song or other item to iPod shuffle in the list of devices.

You can also drag entire playlists to sync them with iPod shuffle, or select multiple
items and drag them all at once to iPod shuffle.

To remove a song or other item from iPod shuffle:

In iTunes, select iPod shuffle in the list of devices.

Select Music, Audiobooks, or Podcasts under iPod shuffle.

Select a song or other item, and then press the Delete or Backspace key on your
keyboard.

If you manually remove a song or other item from iPod shuffle, it isn't deleted from
your iTunes library.

To use iTunes to create a new playlist on iPod shuffle:
In iTunes, select iPod shuffle in the list of devices, and then click the Add (+) button
or choose File > New Playlist.

Type a name for the playlist.

Click Music or another item in the Library list, and then drag songs or other items
to the playlist.

If you make changes to any of your iTunes playlists, remember to drag the changed
playlist to iPod shuffle when it's connected to iTunes.

Chapter 3 Setting Up iPod shuffle
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To add songs to or remove songs from a playlist on iPod shuffle:
Drag a song to a playlist on iPod shuffle to add the song. Select a song in a playlist and
press the Delete key on your keyboard to delete the song.

To set iTunes to sync music and other audio content automatically:

In iTunes, select iPod shuffle in the list of devices, and then click the Summary tab.
Deselect “Manually manage music.”

Click Apply.

The update begins automatically.

Fitting More Songs on iPod shuffle

If your iTunes library contains songs in higher bit-rate formats, such as iTunes Plus,
Apple Lossless, or WAV, you can set iTunes to convert songs to 128 kbps AAC format
as they're synced with iPod shuffle. This doesn't affect the quality or size of the songs
stored in iTunes.

To convert higher bit-rate songs to AAC format:

Connect iPod shuffle to your computer.

In iTunes, select iPod shuffle in the list of devices.

Click the Summary tab.

Select “Convert higher bit rate songs to 128 kbps AAC.”

Click Apply.

Note: Songs in formats not supported by iPod shuffle must be converted if you want

to sync them with iPod shuffle. For more information about formats supported by
iPod shuffle, see “If you can’t sync a song or other item to iPod shuffle” on page 31.

Chapter 3 Setting Up iPod shuffle
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Listening to Music

Read this chapter to learn about listening to iPod shuffle on
the go.

When you disconnect iPod shuffle from your computer, you can clip on iPod shuffle
and listen to music, audiobooks, podcasts, and iTunes U content. VoiceOver lets you
hear the name of the track (song or chapter in an audiobook or podcast) you're
playing, choose a different playlist, or hear battery status.

Playing Music

After you sync iPod shuffle with music and other audio content, you can listen to it.

WARNING: Before using iPod shuffle, read all safety instructions, especially the
section on hearing damage, in Chapter 7,“Safety and Handling,” on page 34.

To listen to songs and other items on iPod shuffle:

Plug the earphones into iPod shuffle and place the earbuds in your ears.
Slide the three-way switch on iPod shuffle from OFF to play in order (<) or shuffle (23).
Playback begins.

To conserve battery life when you aren’t using iPod shuffle, slide the three-way switch
to OFF.




To Do this

Play or pause Press Play/Pause (>u).

Increase or decrease the volume Press Volume Up (+) or Volume Down (=). You
hear a tone if you change the volume while
iPod shuffle is paused.

Go to the next track Press Next/Fast-forward (»1).

Go to the previous track Press Previous/Rewind (i) within 6 seconds
of the track starting. After 6 seconds, pressing
Previous/Rewind (i) restarts the current track.

Fast-forward Press and hold Next/Fast-forward (»).

Rewind Press and hold Previous/Rewind (i«).

Hear the track title and artist name Press the VoiceOver (=) button.

Hear the playlist menu Press and hold the VoiceOver (=) button. When

you hear the name of the playlist you want, press
the VoiceOver (=) button or Play/Pause (>n) to
select it. You can press Next/Fast-forward (») or
Previous/Rewind (i) to cycle quickly through
your playlists.

Exit the playlist menu Press and hold the VoiceOver (=) button.

The status light blinks green once in response to most of your actions (playing,
rewinding, fast-forwarding, using VoiceOver, changing the volume, and so on). If you
pause iPod shuffle, the status light blinks green steadily for 30 seconds. If you reach
the upper or lower volume limit, the status light blinks orange three times. The battery
status lights are described in “Checking the Battery Status” on page 11.

Setting iPod shuffle to Play Songs in Order or Shuffle Songs

You can set iPod shuffle to shuffle songs or play them in the order in which they're
organized in iTunes. When you turn on shuffle, books, podcasts, and Genius Mixes
aren't shuffled; they play in their iTunes order.

To set iPod shuffle to play songs in order:

Slide the three-way switch to play in order (&).

After the last song plays, iPod shuffle starts playing the first song again.
To set iPod shuffle to shuffle:

Slide the three-way switch to shuffle (23).

To reshuffle songs, slide the three-way switch from shuffle (2Q) to play in order (&)
and back to shuffle again.
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Using VoiceOver

iPod shuffle can help provide more control over your playback options by speaking
track titles and artist names, and announcing playlists for you to choose from.
VoiceOver also tells you battery status and speaks other messages.

To hear these announcements, enable VoiceOver in iTunes. You can enable
VoiceOver when you first set up iPod shuffle, or do it later. VoiceOver is available
in selected languages.

You set VoiceOver options on the Summary tab in iTunes. The following sections
describe how to turn on and customize VoiceOver.

To enable VoiceOver when you set up iPod shuffle:
Connect iPod shuffle to your computer.

Follow the onscreen instructions in iTunes. The Enable VoiceOver option is selected
by default.

Click Continue.

In the Summary tab, under Voice Feedback, choose the language you want from the
Language pop-up menu.

This sets the language for your spoken system messages and playlist names, as well as
many of the song titles and artist names.

Note: To pick a different language for specific tracks, select them in iTunes, choose
File > Get Info, choose a VoiceOver language from the pop-up menu on the Options
tab, and then click OK.

Click Apply.

When setup is complete, VoiceOver is enabled on iPod shuffle.

To enable VoiceOver at any time:

Connect iPod shuffle to your computer.

In iTunes, select iPod shuffle in the list of devices, and then click the Summary tab.
Under Voice Feedback, select Enable VoiceOver.

Click Apply.

Choose the language you want from the pop-up menu under Voice Feedback.
Click Apply.

When syncing is finished, VoiceOver is enabled.
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To disable VoiceOver:

In iTunes, select iPod shuffle in the list of devices, and then click the Summary tab.
Under Voice Feedback, deselect Enable VoiceOver.

Click Apply.

When syncing is finished, VoiceOver is disabled. You'll still hear some system

announcements in English on iPod shuffle, such as battery status, error messages, and
a generic menu of numbered playlists. You won't hear track titles and artist names.

Hearing Track Info
VoiceOver can speak the current track title and artist name while you're listening to
iPod shuffle.

To hear info for the current track:
Press the VoiceOver (=) button during playback.

You hear the current track title and artist name.
You can use VoiceOver to navigate to another title.

To navigate using track info:

« IfiPod shuffle is playing, press the VoiceOver (=) button to hear info for the current
track; press Next/Fast-forward (») to skip to the next track and hear its info; press
Previous/Rewind () to move to the previous track and hear its info.

« IfiPod shuffle is paused, press the VoiceOver (=) button to hear info for the current
track; press Next/Fast-forward (») to hear info for the next track; press Previous/
Rewind () to hear info for the previous track. Press the VoiceOver button or Play/
Pause (»n) to play the track.

Changing Playlists

When VoiceOver is enabled, you can hear the playlist names and choose any

playlist you've synced to iPod shuffle. If audiobooks or audio podcasts are synced

to iPod shuffle, their titles are also read as part of the playlist menu. If VoiceOver is
disabled in iTunes, playlists are identified by numerical order (for example, “Playlist 1,
Playlist 2,”and so on), rather than by name.

The playlist menu announces items in this order:
+ The current playlist (if applicable)

+ “All Songs” (playlist of all the songs on iPod shuffle)

« All playlists, including Genius playlists, in alphabetical order
+ All Genius Mixes, in alphabetical order

+ All podcasts, in alphabetical order

+ All'iTunes U collections, in alphabetical order

« All audiobooks, in alphabetical order
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To choose an item from the playlist menu:
Press and hold the VoiceOver (=) button. You hear the names of your playlists.

When you hear the name of the playlist you want, press the VoiceOver (=) button
or Play/Pause (»u) to select it. The first item in your playlist plays.

When you're listening to the playlist menu, you can press Next/Fast-forward (») or
Previous/Rewind () to move forward or backward in the playlist menu.

To restart a playlist, follow the steps above to select the playlist you want.

To exit from the playlist menu:
Press and hold the VoiceOver (=) button.

Setting Tracks to Play at the Same Volume

The loudness of songs and other audio may vary depending on how the tracks were
recorded or encoded. You can set iTunes to automatically adjust the volume of tracks
so they play at the same relative volume, and you can set iPod shuffle to use that
iTunes volume setting. Sound Check is on by default in iTunes, but not on iPod shuffle.

To set iTunes to play tracks at the same volume:

In iTunes, choose iTunes > Preferences if you're using a Mac, or choose Edit > Preferences
if you're using a Windows PC.

Click Playback and select Sound Check.

To set iPod shuffle to use the iTunes volume setting:
Connect iPod shuffle to your computer.

In iTunes, select iPod shuffle in the list of devices.
Click the Summary tab.

In the Options section, select Enable Sound Check.

Click Apply.

If you haven't turned on Sound Check in iTunes, setting it on iPod shuffle has no effect.
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Setting a Volume Limit
You can set a volume limit for iPod shuffle. You can also set a password in iTunes to
prevent anyone else from changing this setting.

If you set a volume limit for iPod shuffle, the status light blinks orange three times if
you try to increase the volume beyond the limit.

To set a volume limit for iPod shuffle:

Set iPod shuffle to the desired maximum volume.

Connect iPod shuffle to your computer.

In iTunes, select iPod shuffle in the list of devices, and then click the Summary tab.
In the Options section, select “Limit maximum volume.”

Drag the slider to the desired maximum volume.

The initial slider setting shows the volume iPod shuffle was set to when you connected
it to your computer.

WARNING: The volume level may vary if you use different earphones or headphones.

To remove the volume limit:
Connect iPod shuffle to your computer.

In iTunes, select iPod shuffle in the list of devices, and then click the Summary tab.

In the Options section, deselect “Limit maximum volume.”

Locking and Unlocking the iPod shuffle Buttons

You can lock the buttons on iPod shuffle so that nothing happens if you press them
accidentally. This feature requires software version 1.0.1 or later (connect iPod shuffle to
iTunes to update the software).

To lock the iPod shuffle buttons:
Press and hold Play/Pause (»u) for three seconds.

The status light blinks orange three times when the buttons become locked. If you
press a button when the buttons are locked, the status light blinks orange once.

To unlock the buttons:
Press and hold Play/Pause (»n) again for three seconds.

The status light blinks orange three times when the buttons become unlocked.

If you're wearing earphones, you hear a tone when you lock or unlock the buttons.
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Storing Files on iPod shuffle

Use iPod shuffle to carry your data as well as your music.

Read this chapter to find out how to use iPod shuffle as an external disk.

Using iPod shuffle as an External Disk

You can use iPod shuffle as an external disk to store data files.

To sync iPod shuffle with music and other audio that you want to listen to, you
must use iTunes. You can't play audio files that you copy to iPod shuffle using the
Macintosh Finder or Windows Explorer.

To use iPod shuffle as an external disk:

Connect iPod shuffle to your computer.

In iTunes, select iPod shuffle in the list of devices, and then click the Summary tab.
In the Options section, select “Enable disk use.”

You may need to scroll down to see the disk settings.

Click Apply.

When you use iPod shuffle as an external disk, the iPod shuffle disk icon appears on

the desktop on a Mac, or as the next available drive letter in Windows Explorer on a
Windows PC.

When iPod shuffle is enabled as a hard disk and you connect it to your computer, the
status light blinks orange continuously. Be sure to eject iPod shuffle in iTunes before
you disconnect it from your computer.
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Copying Files Between Computers

When you enable disk use on iPod shuffle, you can copy files from one computer to
another. iPod shuffle is formatted as a FAT-32 volume, which is supported by both
Macs and PCs. This allows you to use iPod shuffle to copy files between computers
with different operating systems.

To copy files between computers:
After enabling disk use on iPod shuffle, connect it to the computer you want to copy
the files from.

Important: If iPod shuffle is set to sync automatically, when you connect iPod shuffle to
a different computer or user account, a message asks if you want to erase iPod shuffle
and sync with the new iTunes library. Click Cancel if you don’t want to erase what's on
iPod shuffle.

Using the computer’s file system (the Finder on a Mac, or Windows Explorer on a PC),
drag the files to your iPod shuffle.

Disconnect iPod shuffle, and then connect it to the other computer.
Again, click Cancel if you don’t want to erase what's on iPod shuffle.

Drag the files from iPod shuffle to a location on the other computer.

Preventing iTunes from Opening Automatically
You can keep iTunes from opening automatically when you connect iPod shuffle to
your computer.

To prevent iTunes from opening automatically:

Connect iPod shuffle to your computer.

In iTunes, select iPod shuffle in the list of devices, and then click the Summary tab.
In the Options section, deselect “Open iTunes when this iPod is connected.”

Click Apply.
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Tips and Troubleshooting

Most problems with iPod shuffle can be solved quickly by
following the advice in this chapter.

The 5 Rs: Reset, Retry, Restart, Reinstall, Restore

Remember these five basic suggestions if you have a problem with iPod shuffle. Try
these steps one at a time until the problem is resolved. If one of the following doesn't
help, read on for solutions to specific problems.

+ Reset iPod shuffle by turning it off, waiting 10 seconds, and then turning it back
on again.

* Retry with a different USB 2.0 port if you cannot see iPod shuffle in iTunes.

* Restart your computer, and make sure you have the latest software updates
installed.

« Reinstall iTunes software from the latest version on the web.

+ Restore iPod shuffle. See “Updating and Restoring iPod shuffle Software” on page 33.

If the status light glows red persistently or you hear the error message “Please use
iTunes to restore”

Connect iPod shuffle to your computer and restore it in iTunes. See “Updating and
Restoring iPod shuffle Software” on page 33.

If iPod shuffle won’t turn on or respond

+ Connect iPod shuffle to a high-power USB 2.0 port on your computer. Your
iPod shuffle battery may need to be recharged.

+ Turn iPod shuffle off, wait 10 seconds, and then turn it on again.

+ You may need to restore iPod shuffle software. See “Updating and Restoring
iPod shuffle Software” on page 33.

If iPod shuffle isn't playing music
« iPod shuffle might not have any music on it. If you hear the message “Please use
iTunes to sync music,” connect iPod shuffle to your computer to sync music to it.



+ Slide the three-way switch off and then on again.
+ Make sure the earphone or headphone connector is pushed in all the way.

+ Make sure the volume is adjusted properly. A volume limit might be set. See “Setting
a Volume Limit” on page 27.

+ iPod shuffle might be paused. Try pressing Play/Pause (»u).

If you connect iPod shuffle to your computer and nothing happens
+ Connect iPod shuffle to a high-power USB 2.0 port on your computer. Your
iPod shuffle battery may need to be recharged.

+ Make sure you've installed the latest iTunes software from
http://www.itunes.com/download.

+ Try connecting the USB cable to a different USB 2.0 port on your computer.
Make sure the USB cable is firmly connected to iPod shuffle and to the computer.
Make sure the USB connector is oriented correctly. It can be inserted only one way.

+ iPod shuffle might need to be reset. Turn iPod shuffle off, wait 10 seconds, and then
turn it back on again.

« IfiPod shuffle doesn't appear in iTunes or the Finder, the battery may be completely
discharged. Let iPod shuffle charge for several minutes to see if it comes back on.

+ Make sure you have the required computer and software. See “If you want to
double-check the system requirements” on page 32.

« Try restarting your computer.

+ You might need to restore iPod software. See “Updating and Restoring iPod shuffle
Software” on page 33.

+ iPod shuffle may need to be repaired. You can arrange for service on the iPod shuffle
Service & Support website at www.apple.com/support/ipodshuffle/service.

If you can’t sync a song or other item to iPod shuffle

The song might have been encoded in a format that iPod shuffle doesn’t support.
The following audio file formats are supported by iPod shuffle. These include formats
for audiobooks and podcasts:

+ AAC (M4A, M4B, M4P) (8 to 320 kbps)

+ Protected AAC (from the iTunes Store)

+ Apple Lossless (a high-quality compressed format)

+ MP3 (8 to 320 kbps)

« MP3 Variable Bit Rate (VBR)

« Audible (formats 2, 3, 4, Audible Enhanced Audio, AAX, and AAX+)
« WAV

+ AA (audible.com spoken word, formats 2, 3, and 4)

+ AIFF
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A song encoded in Apple Lossless format has near CD-quality sound, but takes up only
about half as much space as a song encoded in AIFF or WAV format. The same song
encoded in AAC or MP3 format takes up even less space. When you import music from
a CD using iTunes, it's converted to AAC format by default.

You can have iPod shuffle automatically convert files encoded at higher bit rates to
128 kbps AAC files as they're synced with iPod shuffle. See “Fitting More Songs on
iPod shuffle” on page 21.

Using iTunes for Windows, you can convert unprotected WMA files to AAC or MP3
format. This can be useful if you have a collection of music encoded in WMA format.

iPod shuffle doesn't support WMA, MPEG Layer 1, MPEG Layer 2 audio files, or
audible.com format 1.

If you have a song in iTunes that isn’t supported by iPod shuffle, you can convert it
to a format iPod shuffle supports. For more information, open iTunes and choose
Help > iTunes Help.

If you want to double-check the system requirements
To use iPod shuffle, you must have:

+ One of the following computer configurations:
+ A Macintosh with a USB 2.0 port
« A Windows PC with a USB 2.0 port or a USB 2.0 card installed

+ One of the following operating systems: Mac OS X v10.5.8 or later, Windows Vista,
or Windows XP Home or Professional with Service Pack 3 or later

 Internet access (a broadband connection is recommended)

+ iTunes 10 or later (you can download iTunes from www.itunes.com/download)

If your Windows PC doesn’t have a high-power USB 2.0 port, you can purchase and
install a USB 2.0 card.

e

High-power USB 2.0 port
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If you want to use iPod shuffle with a Mac and a Windows PC

If your iPod shuffle is set to manually manage music, you can add content to it from
more than one iTunes library, regardless of the operating system on the computer.

If your iPod shuffle is set to sync automatically, when you connect iPod shuffle to a
different computer or user account, a message asks if you want to erase iPod shuffle
and sync with the new iTunes library. Click Cancel if you want to keep the contents of
iPod shuffle as is.

You can use iPod shuffle as an external disk with both Macintosh computers
and PCs, allowing you to copy files from one operating system to the other. See
Chapter 5,“Storing Files on iPod shuffle,” on page 28.

Updating and Restoring iPod shuffle Software

You can use iTunes to update or restore the iPod shuffle software. It's recommended
that you update iPod shuffle to use the latest software. You can also restore the
software, which returns iPod shuffle to its original state.

« Ifyou update, the software is updated but your settings, songs, and other data aren’t
affected.

« Ifyou restore, all data is erased from iPod shuffle, including songs and any other data.
All iPod shuffle settings are restored to their original state.

To update or restore iPod shuffle:
1 Make sure you have an Internet connection and have installed the latest version of
iTunes from www.itunes.com/download.

2 Connect iPod shuffle to your computer.
3 IniTunes, select iPod shuffle in the list of devices, and then click the Summary tab.

The Version section tells you whether iPod shuffle is up to date or needs a newer
version of the software.

4 Do one of the following:
« Toinstall the latest version of the software, click Update.

« To restore iPod shuffle to its original settings, click Restore. Restoring erases all data
from iPod shuffle. Follow the onscreen instructions to complete the restore process.
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Safety and Handling

This chapter contains important safety and handling
information for iPod shuffle.

ﬁ Read all safety information below and operating instructions before using
iPod shuffle to avoid injury.

Keep this user guide for your iPod shuffle handy for future reference.

Important Safety Information

WARNING: Failure to follow these safety instructions could result in fire, electric
shock, or other injury or damage.

Proper handling Do not drop, disassemble, open, crush, bend, deform, puncture,
shred, microwave, incinerate, paint, or insert foreign objects into iPod shuffle.

Water and wet locations Do not use iPod shuffle in rain, or near washbasins or

other wet locations. Take care not to spill any food or liquid on iPod shuffle. In case
iPod shuffle gets wet, unplug all cables, turn off iPod shuffle (slide the three-way switch
to OFF) before cleaning, and allow it to dry thoroughly before turning it on again. Do
not attempt to dry iPod shuffle with an external heat source, such as a microwave
oven or hair dryer.

iPod shuffle repairs Never attempt to repair or modify iPod shuffle yourself. If

iPod shuffle has been submerged in water, punctured, or subjected to a severe fall,

do not use it until you take it to an Apple Authorized Service Provider. iPod shuffle
doesn’t contain any user-serviceable parts. Disassembling iPod shuffle, including the
removal of the back cover, may cause damage that is not covered under warranty.

For service information, choose iPod Help from the Help menu in iTunes or go to
www.apple.com/support/ipod/service. The rechargeable battery in iPod shuffle should
be replaced only by an Apple Authorized Service Provider. For more information
about batteries, go to www.apple.com/support/ipod/service/battery.
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Apple USB Power Adapter If you use the Apple USB Power Adapter (available
separately at www.apple.com/ipodstore) to charge iPod shuffle, make sure that

the power adapter is fully assembled before you plug it into a power outlet. Then
insert the Apple USB Power Adapter firmly into the power outlet. Do not connect
or disconnect the Apple USB Power Adapter with wet hands. Do not use any power
adapter other than the Apple USB Power Adapter to charge your iPod shuffle.

The Apple USB Power Adapter may become warm during normal use. Always

allow adequate ventilation around the Apple USB Power Adapter and use care

when handling.

Unplug the Apple USB Power Adapter if any of the following conditions exist:

+ The power cord or plug has become frayed or damaged.

« The adapter is exposed to rain, liquids, or excessive moisture.

+ The adapter case has become damaged.

+ You suspect the adapter needs service or repair.

+ You want to clean the adapter.

Hearing damage Permanent hearing loss may occur if earbuds or headphones are
used at high volume. Set the volume to a safe level. You can adapt over time to a
higher volume of sound that may sound normal but can be damaging to your hearing.
If you experience ringing in your ears or muffled speech, stop listening and have your
hearing checked. The louder the volume, the less time is required before your hearing
could be affected. Hearing experts suggest that to protect your hearing:

+ Limit the amount of time you use earbuds or headphones at high volume.

« Avoid turning up the volume to block out noisy surroundings

+ Turn the volume down if you can't hear people speaking near you.

For information about how to set a volume limit on iPod shuffle, see “Setting a Volume
Limit” on page 27.

Headphones safety Use of earphones (even if used in only one ear) while driving a
vehicle or riding a bicycle is not recommended and is illegal in some areas. Check and
obey the applicable laws and regulations on the use of earphones and devices such as
iPod shuffle in the areas where you drive or ride. Be careful and attentive while driving.
Stop using iPod shuffle if you find it disruptive or distracting while operating any type
of vehicle, or performing any other activity that requires your full attention.
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Important Handling Information

NOTICE: Failure to follow these handling instructions could result in damage to
iPod shuffle or other property.

Carrying iPod shuffle iPod shuffle contains sensitive components. Do not bend, drop,
or crush iPod shuffle.

Using connectors and ports Never force a connector into a port. Check for
obstructions on the port. If the connector and port don't join with reasonable ease,
they probably don't match. Make sure that the connector matches the port and that
you have positioned the connector correctly in relation to the port.

Keeping iPod shuffle within acceptable temperatures Operate iPod shuffle in a place
where the temperature is always between 32° and 95° F (0° and 35° C). iPod shuffle
play time might temporarily shorten in low-temperature conditions.

Store iPod shuffle in a place where the temperature is always between -4° and 113° F
(-20° and 45° C). Don't leave iPod shuffle in your car, because temperatures in parked
cars can exceed this range.

When you're using iPod shuffle or charging the battery, it's normal for iPod shuffle to
get warm. The exterior of iPod shuffle functions as a cooling surface that transfers heat
from inside the unit to the cooler air outside.

Keeping the outside of iPod shuffle clean To clean iPod shuffle, unplug all cables, turn
it off (slide the three-way switch to OFF), and use a soft, slightly damp, lint-free cloth.
Avoid getting moisture in openings. Don’t use window cleaners, household cleaners,
aerosol sprays, solvents, alcohol, ammonia, or abrasives to clean iPod shuffle.

Disposing of iPod shuffle properly For information about the proper disposal of
iPod shuffle, including other important regulatory compliance information, see
“Disposal and Recycling Information” on page 39.

Compliance Information For compliance information about your iPod shuffle, see
“Regulatory Compliance Information” on page 38.
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Learning More, Service,
and Support

You can find more information about using iPod shuffle in
onscreen help and on the web.

The following table describes where to get iPod-related software and service
information.

To learn about Do this

Service and support, discussions, tutorials,and  Go to: www.apple.com/support/ipodshuffle
Apple software downloads

Using iTunes Open iTunes and choose Help > iTunes Help. For
an online iTunes tutorial (available in some areas
only), go to: www.apple.com/itunes/tutorials

The latest information about iPod shuffle Go to: www.apple.com/ipodshuffle

Registering iPod shuffle Install iTunes on your computer and connect
iPod shuffle.

Finding the iPod shuffle serial number Look under the clip on iPod shuffle. Or, in iTunes

(with iPod shuffle connected to your computer),
select iPod shuffle in the list of devices, and then
click the Summary tab.

Obtaining warranty service First follow the advice in this booklet, the
onscreen help, and online resources, and then go
to: www.apple.com/support/ipodshuffle/service
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Regulatory Compliance Information

FCC Compliance Statement
This device complies with part 15 of the FCC rules.

Operation is subject to the following two conditions:

(1) This device may not cause harmful interference,
and (2) this device must accept any interference
received, including interference that may cause
undesired operation. See instructions if interference
to radio or television reception is suspected.

Radio and TV Interference

This computer equipment generates, uses, and can
radiate radio-frequency energy. If it is not installed
and used properly—that is, in strict accordance with
Apple’s instructions—it may cause interference with
radio and television reception.

This equipment has been tested and found to
comply with the limits for a Class B digital device in
accordance with the specifications in Part 15 of FCC
rules. These specifications are designed to provide
reasonable protection against such interference

in a residential installation. However, there is no
guarantee that interference will not occur in a
particular installation.

You can determine whether your computer system
is causing interference by turning it off. If the
interference stops, it was probably caused by the
computer or one of the peripheral devices.

If your computer system does cause interference
to radio or television reception, try to correct the
interference by using one or more of the following
measures:

* Turn the television or radio antenna until the
interference stops.

Move the computer to one side or the other of
the television or radio.

Move the computer farther away from the
television or radio.

Plug the computer into an outlet that is on a
different circuit from the television or radio. (That
is, make certain the computer and the television
or radio are on circuits controlled by different
circuit breakers or fuses.)

If necessary, consult an Apple-authorized service
provider or Apple. See the service and support
information that came with your Apple product. Or,
consult an experienced radio/television technician
for additional suggestions.

Important: Changes or modifications to this product
not authorized by Apple Inc. could void the EMC
compliance and negate your authority to operate
the product.

This product was tested for EMC compliance under
conditions that included the use of Apple peripheral
devices and Apple shielded cables and connectors
between system components.

It is important that you use Apple peripheral devices
and shielded cables and connectors between
system components to reduce the possibility of
causing interference to radios, television sets, and
other electronic devices. You can obtain Apple
peripheral devices and the proper shielded cables
and connectors through an Apple Authorized
Reseller. For non-Apple peripheral devices, contact
the manufacturer or dealer for assistance.

Responsible party (contact for FCC matters only):
Apple Inc. Corporate Compliance

1 Infinite Loop, MS 26-A

Cupertino, CA 95014

Industry Canada Statement

This Class B device meets all requirements of
the Canadian interference-causing equipment
regulations.

Cet appareil numérique de la classe B respecte
toutes les exigences du Réglement sur le matériel
brouilleur du Canada.

VCCI Class B Statement
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Disposal and Recycling Information

Your iPod must be disposed of properly according
to local laws and regulations. Because this product
contains a battery, the product must be disposed of
separately from household waste. When your iPod
reaches its end of life, contact Apple or your local
authorities to learn about recycling options.

For information about Apple’s recycling program, go
to: www.apple.com/recycling

Battery Replacement and Disposal Information
The rechargeable battery in iPod shuffle should be
replaced only by an authorized service provider. For
battery replacement services, go to: www.apple.
com/batteries/replacements.html

Your iPod shuffle contains a battery. Dispose of your
iPod shuffle according to your local environmental
laws and guidelines.

Deutschland: Dieses Gerat enthélt Batterien. Bitte
nicht in den Hausmull werfen. Entsorgen Sie dieses
Gerates am Ende seines Lebenszyklus entsprechend
der mafgeblichen gesetzlichen Regelungen.

Nederlands: Gebruikte batterijen kunnen worden
ingeleverd bij de chemokar of in een speciale
batterijcontainer voor klein chemisch afval (kca)
worden gedeponeerd.

Taiwan:

mn
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Tiirkiye: EEE yonetmeligine (Elektrikli ve Elektronik
Esyalarda Bazi Zararli Maddelerin Kullaniminin
Sinirlandirilmasina Dair Yonetmelik) uygundur.

European Union—Disposal Information:

X

This symbol means that according to local laws

and regulations your product should be disposed
of separately from household waste. When this
product reaches its end of life, take it to a collection
point designated by local authorities. Some
collection points accept products for free. The
separate collection and recycling of your product
at the time of disposal will help conserve natural
resources and ensure that it is recycled in a manner
that protects human health and the environment.

Union Européenne—informations sur I'élimination
Le symbole ci-dessus signifie que vous devez vous
débarasser de votre produit sans le mélanger
avec les ordures ménageéres, selon les normes et
la Iégislation de votre pays. Lorsque ce produit
n'est plus utilisable, portez-le dans un centre de
traitement des déchets agréé par les autorités
locales. Certains centres acceptent les produits
gratuitement. Le traitement et le recyclage séparé
de votre produit lors de son élimination aideront
a préserver les ressources naturelles et a protéger
I'environnement et la santé des étres humains.

Europdische Union— Informationen zur Entsorgung
Das Symbol oben bedeutet, dass dieses Produkt
entsprechend den geltenden gesetzlichen
Vorschriften und getrennt vom Hausmdill entsorgt
werden muss. Geben Sie dieses Produkt zur
Entsorgung bei einer offiziellen Sammelstelle ab.
Bei einigen Sammelstellen konnen Produkte zur
Entsorgung unentgeltlich abgegeben werden.
Durch das separate Sammeln und Recycling werden
die naturlichen Ressourcen geschont und es ist
sichergestellt, dass beim Recycling des Produkts alle
Bestimmungen zum Schutz von Gesundheit und
Umwelt beachtet werden.

Unione Europea—informazioni per I'eliminazione
Questo simbolo significa che, in base alle leggi e alle
norme locali, il prodotto dovrebbe essere eliminato
separatamente dai rifiuti casalinghi. Quando il
prodotto diventa inutilizzabile, portarlo nel punto
di raccolta stabilito dalle autorita locali. Alcuni punti
di raccolta accettano i prodotti gratuitamente. La
raccolta separata e il riciclaggio del prodotto al
momento dell’eliminazione aiutano a conservare

le risorse naturali e assicurano che venga riciclato
in maniera tale da salvaguardare la salute umana e
I'ambiente.
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Europeiska unionen—uttjdnta produkter Symbolen
ovan betyder att produkten enligt lokala lagar och
bestammelser inte far kastas tillsammans med
hushallsavfallet. Nar produkten har tjanat ut maste
den tas till en atervinningsstation som utsetts av
lokala myndigheter. Vissa atervinningsstationer tar
kostnadsfritt hand om uttjénta produkter. Genom
att Iata den uttjanta produkten tas om hand for
atervinning hjalper du till att spara naturresurser
och skydda halsa och miljo.

Brazil— Disposal information

X

Brasil: Informacgées sobre descarte e reciclagem

O simbolo indica que este produto e/ou sua bateria
ndo devem ser descartadas no lixo doméstico.
Quando decidir descartar este produto e/ou sua
bateria, faca-o de acordo com as leis e diretrizes
ambientais locais. Para informacées sobre o
programa de reciclagem da Apple, pontos de coleta
e telefone de informacoes, visite
www.apple.com/br/environment.

Apple and the Environment

At Apple, we recognize our responsibility to
minimize the environmental impacts of our
operations and products.

For more information, go to:
www.apple.com/environment

© 2010 Apple Inc. All rights reserved. Apple, the
Apple logo, iPod, iTunes, Mac, Macintosh, and Mac
OS are trademarks of Apple Inc, registered in the
U.S. and other countries. Finder and Shuffle are
trademarks of Apple Inc. Apple Store and iTunes
Store are service marks of Apple Inc,, registered

in the U.S. and other countries. Other company
and product names mentioned herein may be
trademarks of their respective companies.

Mention of third-party products is for informational
purposes only and constitutes neither an
endorsement nor a recommendation. Apple
assumes no responsibility with regard to the
performance or use of these products. All
understandings, agreements, or warranties, if any,
take place directly between the vendors and the
prospective users.

Every effort has been made to ensure that the
information in this manual is accurate. Apple is not
responsible for printing or clerical errors.

019-1974/2010-1
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disabling 25
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setting limit 27
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